Лабораторная работа № 5
ОСНОВЫ РАБОТЫ В ГЕОИНФОРМАЦИОННОЙ СИСТЕМЕ SURFER
Введение. О программе

Golden Software Surfer – геоинформационная система (ГИС), предназначенная для моделирования поверхностей – создания карт изолиний, 3D-моделей, векторных карт, карт с теневым рельефом, профилей, графиков функций с двумя переменными и других объектов. Помимо собственно создания карт, программа обладает мощным математическим инструментарием, позволяющим производить значительный объем вычислений и анализа моделированной поверхности. К числу возможностей программы относятся вычисление площади поверхности и объёма между двумя поверхностями, вычисление углов наклона в каждой точке поверхности и построение карт изолиний, соединяющих точки с одинаковым углом наклона (в определённом направлении или максимальным из всех направлений), визуализация освещённости/затенения рельефа при заданном вертикальном и горизонтально угле Солнца, сглаживание поверхностей, рассечение поверхностей (построение профиля), построение поверхности по функции, сложение, вычитание поверхностей и другие операции с ними и т.д.
Программа создана американской компанией Golden Software, занимающейся разработкой пакетов научной графики. Помимо программы Surfer, данная компания выпустила ещё ряд программ, применяемых специалистами в области наук о Земле. К их числу относятся Grapher – программа для построения графиков (одна из лучших программ в этой области, позволяет строить графики 54 типов, обладает огромным количеством возможностей по их оформлению), Strater – программа для создания геологических разрезов и колонок, Voxler – для графического представления трёхмерных данных, Didger – для оцифровки изображений, MapViewer – для создания тематических карт.
Теоретические основы создания цифровых моделей поверхностей

Моделирование поверхностей осуществляется на основе совокупности точек, каждая из которых имеет три координаты – Х, Y и Z. При этом координаты Х и Y являются позиционными характеристиками, то есть определяют положение данной точки на плоскости (географические или прямоугольные координаты), а Z – некоторая количественная характеристика того показателя, по которому строиться карта поверхности. Если Z будет обозначать высоту точки, тогда координаты X, Y и Z будут характеризовать положение каждой точки в трёхмерном пространстве, что является основой для цифрового моделирования рельефа. Однако, кроме рельефа, координата Z может отражать и любую другую характеристику, например, показатель концентрации какого-то загрязнителя в данной точке, среднегодовое количество осадков, температура, влажность почвы и т. д.
Такую информацию (совокупность точек, характеризуемых пространственными координатами Х и Y и количественным значением картографируемого явления) можно визуализировать как в двухмерном (в виде карты изолиний), так и в трёхмерном виде (рисунок 1). Строго говоря, в последнем случае модель не является трёхмерной – фактически она представляет собой поверхность нулевой толщины. Для истинно трёхмерных объектов применяют термин «тела», и они могут содержать более 1 z-координаты на каждую точку (рисунок 2). Несколько условно поверхности называют 2,5-мерными объектами, как занимающие промежуточное положение между плоскостями и истинно трёхмерными объектами. 
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	Рисунок 1 – Цифровые модели рельефа в виде двухмерной плоскости (карта изолиний) и 2,5-мерной поверхности, выполненные в программе Surfer
	Рисунок 2 – Пример цифровой модели трёхмерных тел, выполненные в программе Voxler


При создании цифровых моделей рельефа (ЦМР) ГИС может оперировать с десятками и сотнями тысяч высотных отметок, а не с единицами и десятками, что было возможно и при использовании методов «бумажной» картографии. В связи с доступно​стью быстрой компьютерной обработки громадных массивов высотных данных становится реально выполнимой задача создания максимально приближенной к действительности ЦМР. На основе ЦМР, в свою очередь, возможно быстрое создание серии тематиче​ских карт важнейших морфометрических показателей: гипсометриче​ской карты, карт крутизны и экспозиций склонов, а на их основе и карт эрозионной опасности, направлений поверхностного стока, геохи​мической миграции элементов, устойчивости ландшафтов и т.п. Цифровые модели рельефа - это особый вид трёхмерных математических моделей, представляющий собой отображение «рельефа» как реальных, так и абстрактных геополей (поверхностей). При этом в качестве «рельефа по​верхности» в цифровой модели могут выступать, кроме реального релье​фа, различные другие показатели и характеристики: атмосферное давление, температура воздуха, осадки, пластовое давление нефти, геофизиче​ские поля, концентрация загрязняющих веществ и т.п. [1].
Для любой территории, которую планируется представить в виде цифровой модели, должно быть определённое количество точек, на основании которых и будет моделироваться данная поверхность. Числовые характеристики точек могут быть получены на основе натурных измерений, расчётов или оцифровки изолиний с бумажной (аналоговой) карты. Число этих точек конечно (пусть даже оно может быть очень большим), исходные точки могут быть по-разному распределены в пространстве. Сбор данных может осуществляться по точкам регулярной сетки, по структурным линиям рельефа или хаотично. Восстановление поверхностей (то есть расчёт значений картографируемого показателя за пределами изначально заданных точек) реализуется на основе интерполяции исходных данных.

Интерполяция – восстановление функции на заданном интервале по известным ее значениям конечного множества точек, принадлежащих этому интервалу. 
В ГИС существует два основных подхода к цифровому моделированию рельефа – с использованием моделей TIN (нерегулярная триангуляционная сеть) и GRID (регулярная сетка высотных отметок).
TIN (Triangulated Irregular Network) – нерегулярная триангуляционная сеть, система неперекрывающихся треугольников (рисунок). Вершинами треугольников являются исходные опорные точки. Рельеф в этом случае представляется многогранной поверхностью, каждая грань которой описывается либо линейной функцией (полиэдральная модель), либо полиноминальной поверхностью, коэффициенты которой определяются по значениям в вершинах граней треугольников. Для получения модели поверхности нужно соединить пары точек ребрами определенным способом, называемым триангуляцией Делоне.
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Рисунок 3 – Пример цифровой модели рельефа, построенной на основе TIN-модели

Образовавшиеся треугольники максимально приближаются к равносторонним. Каждая из сторон образовавшихся треугольников из противолежащей вершины видна под максимальным углом из всех возможных точек соответствующей полуплоскости. Интерполяция выполняется по образованным ребрам. Отличительной особенностью и преимуществом триангуляционной модели является то, что в ней нет преобразований исходных данных. С одной стороны, это не дает использовать такие модели для детального анализа, но с другой стороны, исследователь всегда знает, что в этой модели нет привнесенных ошибок, которыми грешат модели, полученные при использовании других методов интерполяции. Это самый быстрый метод интерполяции. Однако, если в ранних версиях большинства ГИС триангуляционный метод был основным, то сегодня большое распространение получили модели в виде регулярной матрицы значений высот (GRID).
GRID-модель (от англ. grid – сетка) представляет собой совокупность точек, равномерно распределённых по территории (рисунок) в узлах геометрически правильной сети. То есть расстояние между всеми точками одинаково. Исходный массив точек преобразуется в GRID с помощью одного из интерполяционных алгоритмов. 
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Рисунок 4 – Пример цифровой модели рельефа, построенной на основе GRID-модели

Основной недостаток GRID-модели в том, что она может нивелировать резкие изменения рельефа, если они проявляются на расстоянии, меньшим, чем расстояние между соседними узлами сети, а также в том, что построение модели рельефа происходит не по исходным, а по преобразованным данным, что обуславливает возможность появления ошибок в процессе преобразования. Программа Surfer использует именно GRID-модель для создания цифровых моделей рельефа.
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Рисунок 5 – Объёмная модель рельефа Африки
Интерфейс и начало работы в Surfer
Главное окно Surfer 12 показано на рисунке ниже. При первом запуске Surfer автоматически создаётся новое пустое окно плот-документа Plot1 (рисунок 6). Окно плот-документа является тем рабочим пространством, внутри которого можно создавать сеточные файлы и карты, сопровождать их подписями и простыми графическими объектами (полигонами, прямоугольниками, эл​липсами, символами и т. п.).
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Рисунок 6 – Окно Plot
1 – печатная страница, 2 – менеджер объектов, 3 – менеджер свойств, 4 – непечатаемая область, 5 –название документа, 6 – главное меню; панели: 7 – стандартная, 8 – вид, 9 – рисование, 10 – карта; 11 – горизонтальная и вертикальная управляющие линейки

Главное меню этого окна содержит следующие пункты:
	File (Файл)
	команды для открытия и сохранения файлов, печати карт, изменения параметров печати и создания новых документов, экспорта и импорта информации и изображений;

	Edit (Правка)
	команды для работы с буфером обмена и вспомогательные ко​манды редактирования объектов;

	View (Вид)
	команды, контролирующие внешний вид текущего окна документа;

	Draw (Рисование)
	команды для создания текстовых блоков, полигонов, полили​ний символов и фигур;

	Arrange (Упорядочение)
	команды, контролирующие порядок и ориентацию объектов;

	Grid (Сетка)
	команды для создания и модификации сеточных файлов;

	Map (Карта)
	команды для создания и модификации карт различных видов;

	Geoprocessing (Геообработка)
	команды для изменения формы графических объектов

	Tools (Инструменты)
	команды для упорядочения размещения команд в главном меню и панелях инструментов

	Window (Окно)
	команды для выбора варианта расположения нескольких открытых окон

	Help (Справка)
	обеспечивает доступ к справочной службе.


Большую часть окна плот-документа занимает печатная страница. При отправке на принтер создаваемых в Surfer изображений обычно печатается только то, что помещается внутри этой страницы. По умолчанию открывается страница формата А4. Размер и ориентацию страниц можно выбрать командой File > Page Setup. Максимальный размер страницы по умолчанию – 279 см по диагонали, есть возможность увеличения до 5080 см.
Слева от печатной страницы находятся менеджер объектов и менеджер свойств. Если при первом запуске Surfer один из них или оба отсутствуют, то следует выполнить команду View > Object Manager (Вид > Менеджер объектов) или View > Property Manager (Вид > Менеджер свойств). Это важные инструменты управления соз​даваемыми в окне плот-документа изображениями. Посредствам них регулируются все элементы оформления создаваемых карт и поверхностей (цвет, размер и форма изолиний, заливок, подписей, осей и т. д.). Без них нельзя обойтись в том случае, когда создаётся оверлей (т. е. наложение одной на другую) не​скольких карт.
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Рисунок 7 – Окно Sheet
Помимо окна Plot (Чертёж), открываемого по умолчанию при запуске программы и предназначенного для визуализации графических объектов, существует также окно Sheet (Таблица). Для открытия нового окна Plot выбирается команда File > New > Plot, для открытия окна Sheet – File > New > Worksheet. Окно Sheet (рисунок 7) предназначено для хранения тех данных, по которым будет построена карта.

В окне Sheet изменяется перечень команд Главного меню. Ряд команд, относящихся к редактированию графических объектов, исчезает, и появляются новые: Format (Формат) – установка формата ячеек, ширины столбцов и высоты строк и Data (Данные) – команды для сортировки данных, вычисления статистических характе​ристик и выполнения математических трансформаций.

Подготовка данных для построения цифровых моделей

В таблицу окна Sheet необходимо заносить XYZ-данные о каждой точке, то есть данные о значении её абсциссы (Х, как правило, записывается в первый столбик – А), ординаты (Y, как правило, записывается во второй столбик – В) и количественные значения какого-либо признака (или признаков) в данной точке (Z, как правило, записывается в третий и последующие столбики) (рисунок 7). Не допускается пропуск каких-либо значений для каких-либо точек. В первую строку таблицы можно записывать пояснения или обозначения.
После ввода значений всех точек файл таблицы необходимо сохранить (File > Save as…). Стандартный формат для файлов таблиц Surfer – [.dat]. Именно этот тип файла рекомендуется выбирать при сохранении таблицы с вручную введёнными значениями точек. Помимо этого, свои данные можно вводить и хранить в документе Microsoft Excel, так как Surfer последних версий без проблем работает с обоими его форматами – [.xls] и [.xlsx]. Вместе с программой Surfer поставляются многочисленные учебные файлы различных форматов, в том числе файлы таблиц, которые можно использовать при обучении работе с программой. Они хранятся в папке Samples, которая размещена в той папке, куда устанавливалась программа. Один из примеров таких учебных файлов в формате [.dat] показан на рисунке 7.
Ручной ввод данный применяется, если данные получены в ходе полевых исследований (при этом координаты точек могут определяться как вручную на картах или планах, так и с помощью gps-навигаторов), либо рассчитаны, либо имеются в готовом виде из других источников.
Ещё одним методом получения данных является оцифровка изолиний (в основном горизонталей) с карты или топоплана для построения объёмной модели рельефа. Оцифровка может производиться в одной из ГИС, где такая возможность реализована, например, в ГИС MapInfo. 

Таким методом можно получить файл, содержащий XYZ-данные от нескольких тысяч точек (для небольшой территории) до сотен тысяч точек (при подробной оцифровке горизонталей крупных территорий), чего нереально достичь при ручном вводе.
Вообще, количество точек, достаточное для построения модели, в каждом случае определяется индивидуально. Оно зависит как от желаемой подробности модели, так и от размера территории, а также от характера распределения картографируемого явления: например, климатические показатели изменяются значительно постепеннее, чем высоты рельефа, поэтому и количество точек, необходимых для построения модели распределения какого-либо климатического показателя, нужно гораздо меньше. Моделирование загрязнения от точечных стационарных источников тоже требует меньшего количества точек, чем от мобильных источников в городах, где загрязнение распространяется от сложно организованной системы большого количества линейных объектов.
Создание grid-файла

После того, как создан файл с числовыми значениями рельефа в каждой точке, его нужно преобразовать в grid-файл – файл с точками в узлах геометрически правильной сетки. В качестве примера будем использовать данные таблицы 1, где дана информация о 20 точках, для каждой из которых известны прямоугольные координаты, абсолютная отметка рельефа и абсолютная отметка уровня грунтовых вод. 
Таблица 1 – Пример исходных данных
	Номер точки
	X, м
	Y, м
	Абсолютная отметка рельефа, м
	Абсолютная отметка уровня грунтовых вод, м
	Номер точки
	X, м
	Y, м
	Абсолютная отметка рельефа, м
	Абсолютная отметка уровня грунтовых вод, м

	1
	1000
	8000
	433,5
	420,8
	11
	8500
	11500
	237
	227,5

	2
	1500
	6500
	335,0
	326,7
	12
	8000
	8500
	428,7
	419,2

	3
	3500
	10000
	247,5
	235,2
	13
	8500
	7000
	319
	313,8

	4
	3500
	7500
	343,1
	339,3
	14
	7500
	6500
	290,1
	285,9

	5
	3500
	5500
	257,6
	252,3
	15
	7500
	6000
	270
	263,7

	6
	1800
	2500
	262,2
	249,1
	16
	12000
	9500
	440,7
	434,1

	7
	6000
	9000
	239,2
	233,2
	17
	10500
	5000
	248
	243,2

	8
	4500
	7500
	436,8
	432,4
	18
	9500
	2000
	244,6
	234,6

	9
	5500
	6500
	239,3
	229,2
	19
	13000
	7500
	266,2
	258,2

	10
	6500
	4000
	271,2
	260,9
	20
	12000
	4500
	306,1
	296,9


Перенесём данные из таблицы 1 в таблицу Surfer и сохраним её под названием «Рабочие данные» расширением [.dat] либо в таблицу Excel с тем же названием. Выберем в Командной строке команду Grid > Data, и в открывшемся диалоговом окне Open Data выберем сохранённый нами файл и жмём кнопку Открыть (рисунок 8)
	[image: image8.png]C @z ®
[T — [lBuicoraDAT
B Agmncrpsrop & Bucomixt
Dounorep 5 e
@cen £ Mporpsus
B StatSoftRegistation ¢ T
8 utitiey | Ta6nmuanisx
8 Bexrop. [ Toundat
[ Konscxwi nonyocrpos. {78 @ororpadum u pucymean
C F—— v
[ = S——— - [ omeem
o gainos: (Al Rocognied Typen C2) o) [omee)
Open worsheets: Database...





	[image: image9.png]<ktop\Pabosie AarHes

Output GidFle
C:Wsers\Aamwmcrparop\Desktop Patoune Aanbie.ard =
GrdLine Geometry

Miimum Masimum Spaong  #ofNodes
XDrecton: 1000 13000 plppe | w0
Y Drecton: 2000 11500 Dimers |

[Pl grd outsce comexulofata 2 Transtom: (Inear 7]






	Рисунок 8 – Диалоговое окно Open Data
	Рисунок 9 – Диалоговое окно Grid Data


Появляется диалоговое окно Grid Data (рисунок 9), в котором мы выбираем основные параметры создаваемого grid-файла. В разделе Data Columns в верхнем левом углу окна мы выбираем, из каких колонок исходного файла «Рабочие данные» мы будем брать значения Х, Y и Z. Для начала построим сеточный файл по абсолютным отметкам рельефа, поэтому для значений Z выбираем ту колонку, в которую помещены именно эти данные. В меню Gridding Method мы выбираем алгоритм, по которому будет строится сеточный файл. Подробнее об этих алгоритмах и их особенностях можно прочитать тут [3-6], а в общем случае будем выбирать вариант Kriging. Наконец, в строке Output Grid File выбираем папку, в которую будет помещён созданный grid-файл (у него расширение [.grd]). Нажимаем ОК, и файл создаётся и помещается в выбранную папку. Если предварительно поставить галочку на Grid Report (в верхней правой части окна), то после создания файла на экран будет выведен отчёт о нём, в котором будет содержаться большое количество статистических и других его характеристик.

Создание карт и редактирование их свойств
Теперь на основе созданного grid-файла можно построить карты или объемные изображения. Для этого необходимо выбрать команду Map > New. Появится список возможных типов изображений (рисунок 10):
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	Рисунок 10 – Виды доступных для создания карт в программе Surfer
	Рисунок 11 – Диалоговое окно Open Grid



К основным из них, которые могут пригодиться на начальном этапе работы с Surfer, относятся:

1. Base Map (Основная Карта) – любое изображение в обычных векторных и растровых форматах – [.jpeg], [.bmp], [.png], [.shp], [.tif], [.jpx], [.dxf] и многие другие.  Такие изображения могут использоваться как подложка, на которую можно наложить, к примеру, созданную карту изолиний. Ряд форматов позволяет открывать изображения, созданные в других ГИС и графических программах – ArcGIS, MapInfo, AutoCAD и др., перенести информацию с JPS-навигаторов и т.д.
2. Contour Map (Контурная Карта) – карта изолиний
3. Post Map (Карта Точек) – создаёт карту исходных точек на основе файла с расширением [.dat] или [.xlsx].

4. Classed Post Map (Классифицированная Карта Точек) – то же, что и предыдущее, однако точки разделены на классы по величине показателя Z, и точки каждого класса показаны отдельным значком.

5. 1-Grid Vector Map (Векторная Карта) – карта, на которой векторами показаны направления изменения показателя Z. Длина вектора отражает интенсивность изменения показателя.

6. Watershed Map (Карта водосборных бассейнов) – программа определяет местоположения линий водоразделов и делит территорию на бассейны.
7. 3D-Wireframe (3D-Каркас) – объёмный каркас.
8. 3D-Surface (3D-Поверхность) – объёмная поверхность.

После выбора необходимого типа карты появляется диалоговое окно Open Grid, в котором необходимо выбрать файл, на основе которого и будет построена карта или поверхность, и нажать на кнопку Открыть (рисунок 11).

После этого на странице в окне Plot появиться нужная карта. 
Карты изолиний

Итак, создадим карту изолиний на основе нашего grid-файла – [Рабочие данные.grd] (рисунок 12)
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Рисунок 12 – Карта изолиний, созданная по исходным рабочим данным в таблице 1
Рассмотрим возможности редактирования данной карты. Как видим, в Менеджере объектов (Object Manager) появился ряд элементов, имеющих отношение к нашему изображению. Это такие элементы, как Map (вся карта в целом со всеми её элементами), Right Axis (правая ось), Left Axis (левая ось), Top Axis (верхняя ось), Bottom Axis (нижняя ось), Contours (собственно изображение). Убрав галочку напротив соответствующего элемента, можно его временно отключить.
Если выделить тот или иной элемент (например, на рисунке 12 выделен элемент Contours), то в нижележащем окне Менеджер свойств (Property Manager) появляются инструменты для редактирования данного конкретного элемента. Рассмотрим эти инструменты. При выделении элемента Map в Менеджере свойств появляются следующие основные вкладки (рисунок 12):
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	Вкладка View (Обзор). Здесь можно редактировать следующие характеристики:

– Projection (проекция): можно выбрать один из двух вариантов – Orthographic (ортогональная, когда взгляд наблюдателя перпендикулярен плоскости изображения) или Perspective (перспективная), когда взгляд наблюдателя под углом к плоскости карты (рисунок 14);
– Rotation (вращение) – можно задавать угол поворота карты против часовой стрелки;

– Tilt (наклон) – можно задавать угол наклона карты, когда используется перспективная проекция; при 90° проекция становится ортогональной, при 0° плоскость превращается в линию;

– Field of View (поле зрения) – позволяет выбирать величину поля зрения при перспективной проекции.
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	Вкладка Scale (Масштаб):
– Proportional XY scaling (Пропорциональное масштабирование) – если на данном пункте стоит галочка, то при любых изменениях размеров осей, соотношения их исходных длин будут сохраняться, если не стоит – можно менять размеры осей независимо друг от друга;
Затем идут две одинаковых группы показателей, каждая из которых включает

– Map units per cm – количество единиц, которые будут отражены на оси (в нашем примере – метров) на 1 см оси;
– Length (page units) – длина оси.

Первая группа для горизонтальной оси, вторая – для вертикальной.
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	Вкладка Limits (Границы). Здесь задаются значение начальных и конечных точек границ карты по горизонтали (X) или по вертикали (Y). Если поставит галочку на Use data limits (использовать границы данных), то границы карты будут проходить прямо по координатам самых дальних точек соответствующих сторон
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	Вкладка Frame (Рамка). Здесь задаются параметры рамки вокруг изображения и его внутренней заливки:
– Style – сплошная или прерывистая, с выбором длины отдельных фрагментов;

– Color – цвет рамки;
– Opacity – степень насыщенности цвета;
– Width – ширина рамки (от 0 до 1,27 см);
– Pattern – стиль фоновой заливки карты (без заливки, сплошная, штриховая, точечная и др.);

– Foreground color – цвет заливки;

– Foreground opacity – степень насыщенности цвета заливки.



	Рисунок 13 – Свойства и атрибуты элемента Map и инструменты их изменения
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Рисунок 14 – Проекции карты: а – ортогональная; б – перспективная с углом наклона 45°, в – перспективная с углом наклона 45° и увеличенным значением поля зрения

Изначально единицами измерения в Surfer (ширина линий, размер значков, шкала управляющих линеек и т.д.) установлены дюймы (Inches). Для того, чтобы дюймы заменить на сантиметры (cm) необходимо выбрать команду Tools > Options. В разделе General этого окна в последней строке Page units заменить Inches на Centimeters (рисунок 15).
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Рисунок 15 – Выбор сантиметров в качестве единиц измерения в Surfer
При выделении элемента Right Axis (или любой другой оси – левой, верхней нижней – их свойства аналогичны) в Менеджере свойств появляются следующие основные вкладки (рисунок 16):
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	Вкладка General (Общие). Состоит из трёх разделов – редактирование самой линии (Line Properties) оси, редактирование текста подписи оси и редактирование подписей точек на оси.
В разделе Line Properties доступны изменения следующих показателей:

– Style – стиль линии оси (отсутствие линии, сплошная линия, прерывистая с разным размером отрезков и т.д.);

– Color – цвет оси;

– Opacity – степень насыщенности цвета;

– Width – ширина оси (от 0 до 1,27 см).

В разделе редактирования текста подписи оси:

– Text title – в поле рядом можно написать заголовок оси, а нажатие кнопки с символом ∑ справа от поля позволяет вызвать окно его редактирования;
– Offset along axis – позволяет смещать текст заголовка оси вдоль оси;

– Offset from axis – позволяет смещать текст заголовка оси поперёк направления оси;

– Angle (degrees) – позволяет поворачивать заголовок на заданный угол;

– Font Properties – выбор шрифта, размера, цвета и др. характеристик текста названия оси.

В разделе редактирования подписей точек оси доступны:

– Show – показать или скрыть подписи к точкам на оси;

– Angle (degrees) – поворот подписей;

– Offset from axis – расстояние от оси до подписей точек
– Label Format – формат чисел, которыми подписываются данные – тип, количество знаков после запятой, разделение точками, префикс, суффикс и др.

– Font Properties – оформление подписей: шрифт (Font), размер шрифта (Size), цвет шрифта и его насыщенность (Foreground color и Foreground opacity), цвет и насыщенность фона (Background color и Background opacity), курсив (Italic), полужирный (Bold), зачёркнутый (Strikeout), подчёркнутый (Underline)

	[image: image22.png]Property Manager - Map:
General | Ticks | Scaling | Grid Lines | Info

Outside
Length

Length

[Minor ticks per




	Вкладка Ticks (Штрихи). Для редактирования штрихов, отмечающих на осях местоположения точек:
– Style – местоположение штрихов: с внешней стороны оси (Outside), с внутренней стороны (Inside), на самой оси (Cross) или отсутствуют (None).

– Length – длина штриха.

Первая группа этих показателей – для основных штрихов вторая – для дополнительных, в этом случае добавляется ещё один параметр:

– Minor ticks per major – количество дополнительных штрихов между двумя соседними основными
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	Вкладка Scaling (Масштабирование):

– Axis minimum и Axis maximum – численное значение начала и конца оси;

– Major interval – интервал между соседними подписанными значениями;

– First major tick и Last major tick – первое и последнее подписанное на оси значение;

– Cross X axis at и Cross Z axis at – в каких точках данная ось пересекает соответственно оси X и Z (при наличии);
– Reverse axis – поменять направление шкалы на противоположное (если от начала координат значения шкалы возрастали от 2000 до 11000, то если поставить галочку на этот пункт, они будут от начала координат уменьшаться от 11000 до 2000)



	[image: image24.png][Property Manager - Map: Right Axis

General | Ticks | Scaling | Grid Lines | Info





	Вкладка Grid Lines (Линии сетки) предназначена для редактирования линий сетки, отходящих от данной оси. Здесь линии двух типов – основные (отходящие от подписанных на оси значений или основных штрихов) и дополнительные, расположенные межу основными (их количество задаётся на вкладке Ticks (показатель Minor ticks per major).
В данной вкладе Grid Lines сначала идёт группа параметров для основных линий, затем группа тех же параметров для дополнительных.

– Show – показать или скрыть линии сетки

– свойства Style, Color, Opacity и Width аналогичны таким же свойствам для, например, линий осей на вкладе General.


Рисунок 16 – Свойства и атрибуты элемента Right (Left, Top, Bottom) Axis и инструменты их изменения
Из свойств элемента Contour используется главный образом свойства вкладка Levels (рисунок 17).
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	Вкладки Levels (Уровни):
– Level method – выбор метода построения изолиний (варианты: Simple – обычный, Logarithmic – логарифмический, Advanced – вручную). При выборе варианта Advanced появляется кнопка Edit levels (Редактировать уровни), вызывающая окно Levels for Map  (рисунок 18), в котором можно установить изолинию для любого значения, её форму, цвет, толщину, насыщенность, наличие подписи на данной изолинии, цвет и другие характеристики заливки между изолиниями и т.д.

– Minimum contour и Maximum contour – минимальное и максимальное значение изолинии;

– Contour interval – «шаг» изолиний;

– Major contour every – какая каждая по счёту изолиния будет основной

– Fill contours – заполнить цветами промежутки между изолиниями;

– Fill colors – выбрать цветовую гамму для заливки (нажатие кнопки справа вызывает окно Colormap – рисунок 19).

– Color Scale – активно только при применении заливки и вызывает появление легенды к цветовой заливке (рисунок 20).
Остальные параметры касаются основных и дополнительных изолиний, а также оформления подписей изолиний, редактирование их характеристик аналогично редактирования характеристик других линий и подписей, рассмотренных выше (Show labels – показать или скрыть подписи к изолиниям, Orient labels uphill – ориентировать подписи к изолиниям в одном направлении или в противоположных от осевой линии карты)


Рисунок 17 – Свойства и атрибуты элемента Contour и инструменты их изменения
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	Add – добавить новую изолинию, значение которой посередине между значениями выделенной и предыдущей изолинии; Delete – удалить изолинию.

Щелчок на Level позволяет выбрать минимальное и максимальное значение изолиний, а также интервал между соседними изолиниями; на Line – стиль, цвет и другие параметры изолиний.

Щелчок на значении или какой-либо характеристике конкретной изолинии позволяет изменить только её 


Рисунок 18 – Диалоговое окно Levels for Map. 
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Рисунок 19 – Диалоговое окно Colormap. В меню Presets можно выбрать вариант цветовой раскраски карты. Кнопка Reverse позволяет поменять чередование цветов от меньшего значения Z к большему на противоположное. Наличие ползунков на цветовой шкале и меню Color позволяет устанавливать конкретное значение цвета для конкретного значения диапазона между изолиниями
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Рисунок 20 – Карта изолиний с использованием заливки и легендой

Свойства цветовой шкалы легенды также отражаются в Менеджере свойств при выделении этого элемента в Менеджере объектов (рисунок 20). К ним относятся: Line Properties – свойства линии контура шкалы (такие же как рассмотренные свойства других линий), First – выбор того, какое по счёту значение будет первым подписано на шкале, Frequency – частота подписей (каждое первое значение, каждое второе и т.д.), на рисунке 20 подписано каждое второе значение шкалы; Angle (degree) – угол поворота подписей значений; Font Properties и Label Format – характеристики шрифта и формата подписей данных, аналогичные рассмотренным выше.
Подписи к изолиниям можно размещать в ручном режиме: щёлкнуть правой кнопкой мыши по изображению карты и в выпадающем контекстном меню выбрать пункт Edit Contour Labels… Далее при зажатой клавише Ctrl левой кнопкой мыши можно нажимать на любое место изолинии, где необходимо поставить подпись. Подписи также можно перемещать вдоль изолинии левой кнопкой мыши, а также удалять, выделив и нажав Delete. По окончании работы с подписями следует нажать клавишу Esc для сохранения изменений.
В последних версиях программы Surfer значительно облегчено построение профиля по карте. Для этого необходимо щёлкнуть правой кнопкой мыши по изображению карты и в выпадающем контекстном меню выбрать пункт Add > Profile. Затем отметить на карте точки начала, изменения направления и окончания профиля, завершив его построение двойным щелчком. Профиль будет сразу же создан под картой (рисунок 21). При этом в менеджере объектов появляется два объекта – линия на карте, по которой построен профиль (элемент Base Profile) и сам профиль (элемент Profile) с двумя осями. Характеристики этих объектов можно изменять в менеджере свойств точно так же, как и других.
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Рисунок 21 – Добавление к карте профиля и масштабной шкалы
Ещё одним дополнительным элементом является шкала масштаба (вызывается командой Add > Scale Bar контекстного меня, вызываемого правой кнопкой мыши). В её свойствах можно задавать количество отрезков, длину одного отрезка, ось, для которой построена шкала и т.д.
Команда Measure (Измерение) из того же контекстного меню позволяет производить на карте измерения – длины построенного мышью прямого отрезка линии, длины ломаной линии целиком, площадь и длину периметра замкнутого контура (рисунок 22), эти характеристики показываются в специальном окне.
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Рисунок 22 – Измерение расстояний на карте с помощью команды Measure
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